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System requirements
Before installing Rainbow, you must have at least these minimal computer requests:
1. Pentium III class or more higher, 128Mb RAM
2. Operating System Windows98, Me, Nt (sp6), 2000 (Sp3), Xp (sp1)
3. Explorer 5.0 or higher properly installed
4. MS Access97 or higher properly installed (for advanced database managing)
5. The video card resolution set to 24-bit depth (16.8 millions of colours) and at
least the video matrix set at 800x600 or more.

1. Software and Driver Installation
INSTALLATION NOTES:
Please remember that this software cannot run if a previous version has been
installed on the computer.
Before installing this new software release, please remove the old version
(Start/Settings/Control Panel/Add-Remove Programs) and remove the old working folder
(do this manually).
Also
ensure
that
the
file
"Pegaso.ocx"
contained
in
the
Window/System
(Winnt/System32) directory has been removed. If necessary,
remove it manually.

*** ATTENTION ***
Remember that you cannot use your job files created
with Rainbow release 1.4 or older with this new
software version.
To install the “Rainbow” software:
•
•
•
•
•
•
•
•
•
•

If the CD automatically launches the file index.htm, select a language and
follow the instructions. Otherwise, in the Windows “START” menu, select Run and
type “X:\index.htm”, where X represents the letter used for your CD drive.
Select the printer model you want to install
Select the Rainbow Software icon displayed on the screen
A new window is displayed: select ‘Run this program from its current location’
Then select ‘OK’
A new window is displayed to indicate that an authentic signature has not been
found. Select Yes
The installation screen for the components required by Rainbow is now
displayed.
Check again if the resolution of your screen is at least 800x600 with 24 bit
colour depth (True colour).
If so, select the first MFC icon and follow the indications on the screen. You
are advised to leave the default settings.
Carry out the same operations to install the OLE DB components. ATTENTION!
During installation, a screen will be displayed which has an icon for a
computer with a small globe and the Exit Setup icon at the bottom.
If you are using an update version of Windows, you may receive an ‘FATAL
ERROR SETUP’, but this means only that you have the same or a new release
of these software libraries. Please continue to install the third
application.
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•
•
•

Once you have installed these program libraries, select the Rainbow icon and
continue with the installation. Leave the TYPICAL installation option and do
not alter the installation path, leaving the default settings unchanged.
At the end, the program asks you to restart your PC (this may also be required
on some computers at the end of the installation of the previous two programs.
When you have restarted your computer, the desktop contains the Rainbow icon
and the Start-Programs file includes a Rainbow file.

VERSION INFO
Please remember that odd minor version numbers (like 1.1, 2.3, 4.7 and so on) are
development releases. On the other hand, even minor version numbers identify stable
releases.
Stable releases appear in one version only. Example: there is only one 2.0 version.
The Cim technical support service assists with stable versions only.

2. First Start-up
At first start-up, no password will be required, and the main Rainbow window will be
opened.
For subsequent access, to modify or cancel the password, refer to the “SECURITY”
section.
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3. Security
In the “View” menu, select the “Security” command. This allows you to manage and
handle all the users by assigning the various privileges.

When you select this many, the software will show the password request: it will be
required to enter an “Admin” user password. The default password is also “Admin” with
the “A” in capital case, then press “OK” button. If you have set a different
password, please insert it with capital and minor case characters in properly places.
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•
•
•

Password Encrypted:
If enabled, it leaves asterisk digits instead of your password characters
Program Protection:
If enable, every time you start Rainbow software the password is
requested
Privilege:
o Change Layout Job
By means this privilege the user can modify the card layout, adding or
modifying the graphic objects.
o Data Source
Allow user to access at the “Edit Database” dialog window Hardware Info
Setup
o Job Setup
Allow user to modify the settings of the window “Job Setup”

•

Change:

•

Delete user:
Remove the current user selected (except if the user has
administrator privilege)

•

Set User:

Set the account selected as current software user

•

Set Admin:

Give to the current accout the administrator privilege

•

New User:

Create a new account with the current options selected

•

Exit:
Exit from this
modification before exit)

Apply the changes at the current user selected

Security

Panel

(press

Change

to

save

the

Note:
After every changes press “Change” button to save these modifications
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4. The Menu

File

New

:

creates and opens a new Project Layout
It will be require to type the project name (a new folder with
the project name will be created).

Open :

opens an existing Layout.

Close:

Close the current project.

Save :

saves the Job with its current name.

Save As:

saves the Job with a new name.

Print:

prints the Job using the settings specified in the Job/Setup
menu.

Print preview:

displays a print preview for the Job.

Print Setup:

Select the printer to be used and change the driver settings.

Exit:

Quit the program.

Cut:

copies the object selected in the clipboard and removes it

Edit

from its current position.
Copy:

copies the object selected in the clipboard.

Paste:

takes the object previously copied in the clipboard and pastes
it in the current layout.

Delete:

eliminates the object selected (this can also be done using
the CANC key).
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View
Toolbar:

If ticked in the check box, the toolbar is displayed.

Status Bar:

If ticked in the check box, the status bar is displayed.

Magnetic Tracks:

opens the Show Tracks dialog box allow display

the tracks on

the card layout.
Attention, this options doesn’t change the magnetic settings,
it is only a graphical indication.
Microchip:

Show

the

microchip

on

the

card

layout

where

usually

is

inserted into the plastic card
Grid Setting:

Opens the Grid Settings dialog box allow to display the

card

layout with the grid:

Options(Hide/Show)

:Show or Hide the grid on the

card
Spacing(Width/Height):Set the distance between the
points of the grid
Snap control to grid :Align the sprites to the grid
(if Grid is enabled)

Portrait/Landscape Mode: Allow to set the landscape or portrait visual mode of
the card

Anchor Sprites to card layout: If enabled, anchor the sprites to the card current
position

when

you

turn

the

card

orientation

with

the

Orientation options (Portrait/Landscape mode).
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Machine
Magnetic Encoder: opens the “Writing Magnetic Tracks” dialog box. Used to enter
the coding values (the magnetic tracks paragraph).
ChipProcess:

Open

the

Chip

external

configuration

chip

programmer

panel

to

interface

hardware/software

with

an

(contact

CIM

technical support for more specific information)

Data Source (Database management)
File Source:

displays the “Open” dialog box for selecting the file source
(see also the database paragraph)

System Source:

opens the Data Link Properties dialog box for selecting the
data source.

Create Database:

opens the dialog box which allows to create a database file of
Microsoft Access format (with text, numeric or date fields).

Build RowSet:

displays

the

Rowset

manager

dialog

box

(if

a

database

for

selecting

is

connected).
Field Engine:

opens

the

Field

Engine

dialog

box

the

data

fields to be applied.
Find Record:

opens the dialog box which retrieves one record by data source
and shows it

in

the database view of the application’s

graphic interface

Job
Setup:

opens the

Edit Job dialog box (for the Job setup, see the

Printing paragraph).
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Customize
Options:

Show the panel about the behavior of the software when a
database is connected to our projects.
None: Leave the database used into the
current position
Move DataSource: Move the database file
to the project folder

Video Capture
Source:

All the options inside this menu change from the current OCR
video used.

Capture Alt+C:

Acquires an image from the OCR video source. Only functions if
OcrServer is enabled.

Options:

Displays the OcrServer start and setting window panel.

Window
New Window:

opens a new page in the Layout.

Cascade:

reduces the size of the Layout window.

Tile:

returns the window to its normal size.

Arrange Icons:

arranges the icons in the order established.

(Layout Name):

if ticked in the check box, this indicates which Layout is
selected.

Help
About:

Provided the software version.

Help:

Open the user manual in Acrobat™ file format.

Undo:

Delete the previously operations made until the first save
point.

Zoom:

REV. 03/2005
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4.1 The Toolbar
The following commands are only available in the toolbar; there are no equivalent
commands in the menus.

• File Source:

Displays the “Open” dialog box for selecting
the file source(See also the Database
paragraph)

• Setup:

Opens the dialog box “Job Setup” which allows to
configure the job and allows to prints.

•

Insert a sprite:

Inserts a new sprite at the top left of the page
and opens the sprite setting window

•

Insert a barcode:

Inserts a new barcode at the top left of the page
and opens the barcode property setting window.

•

Move Up:

Moves the object selected to the foreground.

•

Move Down:

Moves the object selected to the background.

•

Flip the card:

Changes the display of the side of the card:
displays the second, hidden, side.

•

Video Capture:

Starts the Video Capture Server.

•

ChipProcess:

Open the Chip configuration panel to interface
with

an

external

chip

programmer

hardware/software (contact CIM technical support
for more specific information).
•

Portrait/Landscape mode:

Show the card in

•

Preview:

Provide the printing preview of the selected card

Portrait or Landscape mode.

layout
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5. Creating a New Project
Press “New” in the “File” menu: this opens the “New layout name” window. Enter a new
name (e.g. Test) in the “Insert new project name” box and press “OK”.
Note that the Full Path, where the files for the new project will be created, is
displayed below.

A card layout with two fully blank sides is created: you can now start to insert
objects such as text, images, barcodes, etc.
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5.1 The Sprite
A Sprite is a bordered space in which you can insert text or images.
To create a Sprite, click on

(Sprite) on the toolbar. Whenever you click on this

icon, a new Sprite is displayed at the top left of the card together with the Sprite
properties dialog box.
This window can be used to set all the properties of a sprite.
To modify the properties of an existing “sprite”, move the mouse onto the “sprite”
you want to modify and click the right mouse button.

left
0,0

x

width
bottom
height

Sprite
generica

y
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•

Left

•

Bottom
These fields can be used to set the position of the sprite (Top,

Life) by indicating the position of the top left corner of the sprite in X, Y coordinates. You can also move the sprite by moving to any point of the rectangle
(the cursor will change to the …..form): press the left mouse button to drag it to
the new position and then release the button.
•

Width

•

Height
These fields can be used to set the dimensions of the sprite (Width,

Height). You can also set the dimensions of the sprite by dragging one of the
handles which are displayed when you select a sprite.

N.B.: All the dimensions are expressed in hundredths of a millimetre.

•

Rotate

This

button

is

used

to

rotate

the

sprite

around itself. When you press this button, note that
the text inside changes to 90, 180 and 270 and then
returns to 0 degrees.
•

Full Screen

This option is used for automatic dimensioning of the sprite in
order to cover the entire card layout. This method is very useful
for setting a card background.

•

Lock Sprite If set, the correspondent graphic object cannot be moved on the
card layout with the mouse.

•

OK

Applies the modifications to the sprite and closes the property box

•

Apply

Applies the modifications to the sprite but does not close the
property box

•

Cancel

Cancels

all

the

modifications

not

yet

applied

and

closes

the

property box
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5.1.1 Gradient Panel
Used to specify the settings of
the sprite background color, if
present:
- No Background: The sprite
will use the white as background
color
- Single Color :
The
sprite background color is
the color displayed beside
the “From Color” button
-“From Color”: Allows you to
set
the
background
color
using
the
Windows
color
window
- Gradient: If you choose this
option,
the
background
color
will
be a
mix
between the
starting color given by the
“From Color” and the destination
color given by the “To Color”
- “To Color”: this button
functions like “From Color”.
However,
it
sets
the
destination color (only used
by the gradient function)
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5.1.2 Text Panel

Used to specify the text to be inserted in the sprite.
Inside the project you can insert how many text sprites your need, each one with a
different font, style and color.
•
•
•
•
•

•
•

•

Font : Opens the MSWindows window for selecting the font to set the text
character properties.
Color Text: Opens the Windows window for selecting the text color.
Left/Center/Right : These are the horizontal text alignment buttons:
respectively, left-aligned, centred and right-aligned
Single line: Indicates whether the text is to be arranged on one line only
or on more than one line (not more that 5 for single sprite)
Static(Top/Center/Bottom): These “Static” group buttons are only enabled if
the “Single line” option is enabled. They relate to the vertical text
alignment within the sprite. Respectively, the used as follows: top-aligned,
centred and bottom-aligned
Word Break: This option indicated whether the automatic word break function
is enabled. Clearly, this is only possible if, the “Single line” option is
disabled.
Ellipsis: This option is enabled if the previous (Word Break) function is
disabled and if the characters present in a line exceed the dimensions of
the sprite: dots will be added to indicate that there is text which cannot
be displayed
NoPrefix: Nel If you enable this option, all the special characters (%, &,
etc...etc...) will be ignored and will be printed as normal characters.
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5.1.3 Picture Panel

In this page, you can use the “...” button to open the “Open File” window to
look for the file for the image to be inserted in the sprite
After you have selected the file, press ‘Open’ button to load the image: you will
have a preview on the Picture panel, if you press ‘Ok’ or ‘Apply’ the image will be
loaded into the card layout.
•

Destination : Function not used in this current Rainbow release.
NOTE: You can only load Windows Bitmap (.bmp) or Jpeg (.jpg or .jpeg) image
files, others format will aren’t visualizated.
If you will load a image and this one will appears completely black, check if

the actual monitor resolution/color depth are corrects. If yes, try to load the image
with a graphic software and save again the file with a different name.
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5.1.4 Borders Panel
In this page, you can size the sprite borders by dragging them to the required
position.

•

Reverse:

sets the borders as the reverse of the current
borders. For example, if you have only set the top
and bottom borders, press “Reverse” to set only
the right and left borders

•

Color:

opens

the

color

selection

box

for

setting

the

collar of the border lines (frames)
•

Frame’s thickness in dots:

REV. 03/2005
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5.1.5 Settings Panel
This page is used to set general sprite options.

• Draw Transparent;

if

set,

this

sets

the

sprite

background

as

transparent. This option allow to insert text over
other background or picture.
• Stretch bitmap:

if

selected,

this

option

ensures

that

any

image

inserted in the sprite is dimensioned exactly as the
sprite rectangle without accounting for the original
dimensions of the image
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6.

Barcode

With the button

on the tool bar it is possible to insert one or more barcode

into the card layout. Automatically the Barcode Properties will be open and it is
possible to modify every settings.

•

Data: Here it is possible to insert the data used to create the barcode.

•

Ratio/Factor: These parameters define the proportions of the barcode columns.

•

Show Data/Font size: sets the dimensions of the character for displaying the
encoded data item (only if the “ShowData” option is enabled)

•

Lock Barcode: If selected, don’t allow to move the barcode position with the
mouse.

In the same panel you can specify the barcode type you need to prints (default
barcode style : Code 39 Alphanumeric)
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7.
Magnetic
Encoder
Magnetic
Encoder

the Machine
Magnetic
Encoder
or click
on on the
inside
the to
In theInMachine
menu, menu,
selectselect
Magnetic
Encoder
or click
on
toolbar
toolbar to display the Writing Magnetic Tracks window.
display the Writing Magnetic Tracks window.
NOTE: Check into the printer driver panel if the Magnetic encoding feature is
NOTE: Check into the printer driver panel if the Magnetic encoding feature is
enabled, and if the coercivity of the magnetic stripe is correctly set (Hi-Co
enabled, and if the coercivity of the magnetic stripe is correctly set (Hi-Co or
or Low-Co).
Low-Co).
Insert your data or the link to
the database in these fields to
be coded on magnetic tracks.
USE ONLY THE CHARACTERS INDICATED
INTO THE TABLE BELOW.
Insert the data only into the Iso
fields (The Jis Fields are only
for Japanese Standards)

Advanced

Setting

:

This

option

allow you to change the Start and
End of data,
printer

driver

necessary for the
to

execute

the

encodingband.
commands. For
In this window, you can set the data to be coded onmagnetic
each magnetic
Use only the ISO fields (the JIS fields are relative
to the programming
Japanise standards)
specific
necessity it
Use only the characters indicated into the table below :
is possible to change them.

Iso standard characters table :

Iso standard characters table :
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8.

Connecting a Database
In general, the cards are produced starting with a series of data which
identifies, for example, the employees of a company. This data is contained
within a Database.
In the “Data Source” menu, select “File Source” or click on the icon
the toolbar to open the database selection window.

of

NOTE:
From this panel it is possible to connect database file in Ms Access format
(*.mdb) and Dbase format (*.dbf). To load others database format, please see
‘Data Linking Using Microsoft Provider for Database. Rainbow allow database
with only TEXT, NUMERIC or DATE fields. Others fields types may cause errors during
the import operation.
In the Examples file, where the program has been installed, there are two example
databases: let's select, for example, the “cimmdb.mdb” file.
Select “Open”: the “Rowset manager” window can be used to decide on the data origin
within the database.
In the “Table list”, select the CIMENG table: all the records in this table will be
displayed, with all the data for the hypothetical employees.
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The right side of the main window displays the fields for the table selected
and the data for the current record.
Using this data, we derive the information required to generate customised
cards for each record in the database, that is, for every “employee”.

For further information please see also the Rowset Manager paragraph.
At the end of these operations, press “OK” to accept the modifications
Rainbow will be appears as below:
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To insert these data into the card layout as text, barcode data or magnetic
stripe data, the procedure is all the time the same: digits the EXACT NAME of the
required field, between the percent ‘%’ symbols (with the capital and lower case
letter digits correctly).
I.e. %STREET%
It is possible insert more fields in the same Sprite, or insert some fix text
or number beside variable fields (see the examples into the following page).
If we need to import some photos, with the file name indicated into a database,
we need only to create a new Sprite, use the Picture panel, and type into edit bar,
the folder location where we have stored all the images: instead to specify a single
picture, we can insert the connection to the database field that contain the photo
file name. (See the example into the next page)

Text
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Barcode

Magnetic Encoder

Photo
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8.1

Editing the Database Records

Clicking on the Edit button of the database view ,and if the
user has the
granted privilege by Rainbow Administrator, is possible to access the tool which
allows handling the records of the connected database.

The Edit database tool shows all the records in order as stored, also, in the
right side of the dialog box are contained the following commands:
•

•
•

•
•

•

Append: This command joins a new record at the end of the records list.
When you access the tool, the displayed record last is blank; select a field
at will of the last record and double-click on it; now you can enter your
data, then click on Append and if the entered data respect the database
restraints the new record is inserted in the list. However to insert the
new
record in the connected data source you must click on Update button.
Update: This command updates definitively the connected data source.
Delete: This command allows erasing one or more records.
Before to erase some records, you must select them, then clicking on the Delete
button the application asks you if to remove definitively the selected records
or not.
Copy:
This command allows copying whole records. It needs to select some
records before, then to click on the Copy buttons. In this mode the records are
copied in the clipboard of the system.
Paste: This command appends the copied records in the record list. After
copying
of the records in the clipboard, you must select one record,
therefore the copied records are inserted in the list, beginning from selected
record by clicking on the Paste button
Close: This button close the tool Edit Database. If in the current session has
been modified and not updated some record of the list, a message appear to user
before to close the dialog box, to ask if to update the changes definitively or
not.

Note: It isn’t possible to Add or Delete a specific Fields, You need to proceed on
this operation from an external software (like Ms Access)
REV. 03/2005
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9. Data Linking Using Microsoft Provider for Database
Rainbow has the ability to connect to any data sources through the interface
"Microsoft Provider ", allowing save the user name and password, so next time that
open the Rainbow’s file the connection to the source is in automatic mode.
In the Data Source menu, choose System Source to open the Data Link Properties dialog
box, if you possess the granted privilege by Administrator:

That allow choose the specific provider and to enter the necessary parameters
for the connection.
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9.1

Example: Data Linking Using OLEDB Provider for SQL Server

In the Data Source menu, choose System Source to open the Data Link Properties
dialog box:

On the Provider tab, select the OLE DB Provider for SQL Server.
Click Next > > to select the Connection tab.
Execute the following steps for a corrected connection:
1) Type in or choose a server name in the box “Select or enter a server name”;
2) Select
the
option
“Use
a
specific
user
name
and
password”:
Enter user name and password in the respective boxes;
3) Choose the option “Allow saving password” to connect to the source
in
automatic mode next time that open the Rainbow’s file;
4) Select the require database on the box “Select the database on the server”
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5) Test the connection clicking on button

“Test Connection”;

If the following message appears:

then the connection on remote pc is carried out;
6) Close the windows “Data Links Properties ” clicking on Button “OK”;
7) Select the table or a set of records of the database with the window
“Rowset manager ”.
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9.2

Example: Data Linking Using OLEDB Provider for Oracle

In the Data Source menu, choose System Source to open the Data Link Properties
dialog box:

On the Provider tab, select the OLE DB Provider for Oracle.
Click Next > > to select the Connection tab.
Execute the following steps for a corrected connection:
1) Type in or choose a server name in the box “Select or enter a server name”;
2) Enter user name and password in the respective boxes;
3) Choose the option “Allow saving password” to connect to the source in
automatic mode next time that open the Rainbow’s file;
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4) Test the connection clicking on button “Test Connection”;

then the connection on remote pc is carried out;
8) Close the windows “Data Links Properties” clicking

on Button OK;

9) Select the table or a set of records of the database with the window “Rowset
manager” that appear immediately on the screen.
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9.3. Example: Data Linking Using the Provider for ODBC Driver
In the Data Source menu, choose System Source to open the Data Link Properties dialog
box:
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On the Provider tab, select the OLE DB Provider you want to connect to.
Click Next > > to select the Connection tab:

Mark the first option, Use data source name, and select the name of the data
source from the drop-down list. Click Test Connection to check if the font
entered

is

correct.

If

everything

is

right,

the

message

“Test

connection

succeeded” appears on the screen.
Now you are connected to Database. Click OK.
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9.4

Example: Data Linking Using the JET 4.0 Provider for .dbf Files

The connection to Dbase files more stable and flexible can be carried out
through the JET 4.0 Provider.
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After selecting the Jet 4.0 Provider in the Data link properties dialog box,
select the All tab; the following window appear:

Select the first voice Data Source and click on the Edit Value button. The
following dialog box appears:
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Enter the absolute path where the dbase files are located, and click on OK
button.
Select

the

second

voice

Extended

Properties

and

click

on

the

Edit

value,

therefore the following windows appear:

Type in the name that defines the files format, (e.g. DBASE III)
Then click on the OK Button; at this point the connection is carried out, and
clicking on Test Connection button you can verify the connection.
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10.

Rowset Manager
From Data Source menu, find the Build Rowset voice which allows managing data

from one or more tables, and clicking on it the following window appear:

This window is used to manage records of more tables, to insert and to remove
record from database and in general to launch queries on the database to select a
subset of records. All this is done using the SQL commands, to be written in the edit
box beside the Exec button.
E.g.:
Write the string:
SELECT * FROM CIMENG WHERE (CARDNUM > '11000000')
and then press “Exec” to select, from the “CIMENG” table, only the records which have
a code in the “CARDNUM” field which is greater than “1100000000”
For further information about the SQL commands, refer to specialised documentation.
The “Show all record” check box forces the display of all the records present in the
table selected.
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11. Creating an Internal Database
So far we have only considered the possibility of using an existing data source.
However, Rainbow can also be used to create a database.
In the “Data Source” menu, select the “Create Database” command.
The “Create a new database” window is opened.

ATTENTION!
In
these
cases,
Multicard
creates
a
database
called
“NewDatabase.mdb”
in
the
directory for the current job.
If an internal database has
already been created for this
project,
it
will
be
overwritten and all the old
data will be lost.

In the “Create a new Database” window, add fields for the database, such as:

Field Name

Length

Type

FirstName

50

Text

LastName

50

Text

City

50

Text
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Now press “Create” button to create the data file in the same Project Folder:

Select your new database, and then press ‘OPEN’

From the Rowset Manager window are displayed the created fields and one record
to zero.
Clicking on the OK button the connection to database is established, and the database
view shows the current record.
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12.

Field Engine

This tool is accessible from Data Source menu, selecting the Field Engine voice.

This window is important for a number of reasons. First of all, it checks all
the internal and system variables and fields available.
In the Table page in the “Field Engine” window, as well as display all the system
fields, you can also modify their display format.
For example:
for the _Date field
%d %m %Y
%d /%m/%Y

displays
displays

day month year
day/month/year

displays
displays

hours:minutes:seconds
hours h minutes ’ seconds ”

for the _Time field
%H:%M:%S
%H h %M ’ %S ”
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for the number fields like “_Counter”, if you set a value 16 for “_Counter”:
Format

Notes

Preview

%d

Displays

the

number

in 16

decimals
%nd

n

is

a

which
minimum

decimal

number 16

specifies

the

number

of

digits

to display. if the number
has

less

digits,

blank

spaces are inserted (e.g.
%5d)
%0nd

n

is

which
minimum

a

decimal

number 00016

specifies
number

of

the
digits

to display. if the number
has less digits, zeros are
inserted (e.g. %05d)
%X

The number is represented F
in

hexadecimal

notation

with uppercase letters
%x

The number is represented f
in

hexadecimal

notation

with lowercase letters
%02X

The decimal notation rules 0F
apply
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13.

to Print:

When the project layout will be completed, it will be possible prints the card.
After we have selected the correct printer and printer settings, we can select the
“Job” panel, and goes into “Setup” window, or it is possible select directly the
icon from the Toolbar.

As you can see, the window is divided into five zones:
•

How many cards:

•

Do you want log file?:

REV. 03/2005

used to set the number of cards you want to print.
Click on the “All Records” button to set the number of
cards equal to the number of records in the database.
Select the number of copies for each record if you
possess the granted privilege by Rainbow Administrator
This feature is not enabled into this Rainbow release.
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•

Primary index key:

This options works only for Chip-Management application
(contact the Technical Support for further information)

•

Starting from cards:

This box indicates from which records from the
connected database start to print for N records,
indicated into “How many cards” box. If no database are
connected into our project, leave into this box the
default value ‘1’

•

Card Repetition:

This feature is not enabled into this Rainbow release.

After setting all parameters for window “Job Setup”, the job is started by
clicking on the button “Print” of the application graphic interface.

NOTE:

Before starts to print, please check if the current printer
selected is the correct one, otherwise from the menu “Printer
Setup” change the printer model and the printer settings.
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14.

Saving the Project

After modifying the project, you should save it so that you do not lose the
work in the event of operating system problems.
To save the project, select ”Save” from the “File” menu or click
toolbar to save the project with the same name.

on

the

If you want to save the project with a new name, select the command “Save
As...” in the “File” menu. The Windows “Save As” window is displayed: here you can
change the name and destination directory of the project.

NOTE:
The File saved from Rainbow includes only the texts and the
Sprites coordinates. If it is necessary to make a backup copy of
the project, don’t forget to copy also the picture, fonts and the
database used from the project.
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15.

Video capture – OCR server

An extremely interesting Rainbow software option is the possibility of acquiring
images from a video camera and linking them to the database data.
Using our example of customised cards for every employee, you can acquire the image
of the employee using a video camera or from a Webcam, save the image to disk and
link it to the corresponding record.
In the case of the Videocamera, this requires an optional computer card not supplied
with the Rainbow software.
In the case of the Webcam, it is sufficient that the driver is compatible ‘Video for
Windows’ standard.
In the “Video Capture” menu, select the “Options” command and set all the options
for the OCR.
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Click

on

“Browse”

to

locate

the

OCR

server

driver.

This

file

is

named

OcrServer.exe and resides in the main Rainbow directory.

Es.:
C:\Programmi\Cim\Rainbow\OcrServer.exe

Click on “Open”: you can now run the OCR Server by pressing “Run Server”
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The OCR window is opened to display the images acquired using the video camera.
In the “Directory where store images” group in the “Video Cap Options” window, you
can change the destination directory for the files acquired with the video camera
(into our example is C:\PHOTO\).
You can also change the name of the destination file. The options are:
“Fixed” - this means that the program will continue to save the image in the same
temporary file;
“Label” – in the text box, you can enter the name of the file required or the link to
a database field if connected, for example the %CARDNUM% field.
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In our case the file will be saved using the name inside the “CARDNUM” field of
the

current

Record

currently

displayed

(in

the

example

it

will

be

saved

as

C:\PHOTO\00110024.jpg).
By moving into the database, and displayed a different record, the captured
file will be saved with a different name linked to the “CARDNUM” field. This will
allow us to save a different photo for each database records, and link a Sprite to
load these pictures.
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If you enable the “Save Capture File Name To Field” option, a window is opened
for selecting the database field for saving the name of the file (with the complete
destination path), in our case “PHOTO”.
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In the “OcrServer” window, you can select the area to be saved in the file by
clicking and dragging the mouse instead to capture all the photo area.

Then press the capture button

on the toolbar (or Alt+C) to save the

Into the case that the caption is not good, we can press again the Capture button to
overwrite the current capture photo.
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15.1. Display Menu (Visualizza)

Options
In diretta (live):

displays
directly

the

video

source

from

the

video

camera

Cattura singola immagine(Capture single image): limits the acquisition to the current
image displayed
Decodifica OCR(OCR decoding): not enabled.
Sempre in primo piano(Always in foreground):
ensures that the
is always in front of the others

“OcrServer”

window

Barra di stato (Status bar): enables/disables the display of the status bar
Ultime Misure(Last measures): not enabled
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15.2. Configuration Menu (Menu Configurazione)

Sorgente (Source):
Formato (Format):
Display (Display):
These windows depend directly on the video source available (VideoCamera or
Webcam) and change from one producer to another one.

Parametri di sistema (System parameters):

You can use this function to set all the acquisition times in milliseconds and
other OCR configuration parameters.
NOTE
If the images acquired by the video camera are black and white even if a
colour palette is available, in the Rainbow installation directory, close the
Rainbow software and delete the file OcrTemplate.bmp, after that change the
name of the file OcrTemplate24bit.bmp to OcrTemplate.bmp.
If the problem is not solved, please contact the technical support.
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CIM an MF Group SpA Division
Quarters
Via O. Serra, 2
40012 Calderara di
Reno
Bologna - ITALY
Tel. +39 051 64.65.011
Fax + 39 051 64.65.012
E-mail:
cimtech@cimitaly.it
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